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1 About This Manual
This manual enables safe and efficient handling of the device.
This manual is an integral part of the device, and must be kept in close proximity to the
device where it is permanently accessible to personnel. In addition, instructions concerning
labor protection laws, operator regulations tools and supplies must be available and adhered
to.
Before starting any work, personnel must read the manual thoroughly and understand
its contents. Compliance with all specified safety and operating instructions, as well as local
work safety regulations, are vital to ensure safe operation.
The figures shown in this manual are designed to be general and informative and may not
represent the specific Bruker model, component or software/firmware version you are
working with. Options and accessories may or may not be illustrated in each figure.

1.1 Policy Statement
It is Bruker’s policy to improve products as new techniques and components become
available. Bruker reserves the right to change specifications at any time.
Every effort has been made to avoid errors in text and figure presentation in this publication.
In order to produce useful and appropriate documentation, we welcome your comments on
this publication. Field Service Engineers are advised to check regularly with Bruker for
updated information.
Bruker is committed to providing customers with inventive, high-quality, environmentally-
sound products and services.
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1.2 Font and Format Conventions

Type of Information Font Examples

Shell Command,
Commands, 
“All that you can enter”

Arial bold Type or enter fromjdx 
zg

Button, Tab, Pane and Menu Names

“All that you can click”

Arial bold, initial letters
capitalized

Use the Export To File
button.

Click OK. 
Click Processing…

Windows, Dialog Windows, Pop-up
Windows Names

Arial, initial letters
capitalized

The Stacked Plot Edit
dialog will be displayed.

Path, File, Dataset and Experiment
Names
Data Path Variables
Table Column Names
Field Names (within Dialog
Windows)

Arial Italics $tshome/exp/stan/nmr/
lists

expno, procno, 

Parameters Arial in Capital Letters VCLIST

Program Code 
Pulse and AU Program Names 
Macros 
Functions
Arguments
Variables

Courier go=2
au_zgte
edmac

CalcExpTime()
XAU(prog, arg)
disk2, user2

AU Macro Courier in Capital
Letters

REXPNO

Table 1.1: Font and Format Conventions
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2 Main User Interface Features
The new 2D molecule structure editor is integrated into the Structure tab of the TopSpin
spectrum window.
The user interface of the editor consists of several main parts:

• The top horizontal quick access toolbar contains buttons to activate the main features of
the editor like: drawing structures, selection and rotation capabilities, undo/redo support,
file features, editing of the structure properties etc.

• Other toolbars allow selection of an element from the periodic table of elements to be
used in a drawing. The user may also use a template to draw the structure more quickly.

• The drawing area: Used to draw and visualize the structure.
• The popup menu: Provides access to the same features as the toolbar in an alternative

way.
• The status bar: Displays the full path and file name of the opened file.
• The user interface was designed to follow this criteria:

– State of the art UI.
– Simplified use, one click adds an atom (defined bond angle and length).
– Smart utilization of Drag & Drop.

Figure 2.1: Molecule Structure Editor

The editor is similar to other chemical structure drawing programs, but a brief description of
the key buttons is included here:

•  - Used to activate selection mode where object can be selected and moved.

•   - Used to control the zoom level.

•  - Used to scale the structure to its actual size.

•   - Activates the drawing mode for normal bonds or chains.
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•  - Activates erase mode and deletes all touched bonds or atoms (highlighted in red
before deleting).

•  - Deletes the selection.

•    - Used for stereo bond definition (note that at this time CMC-se ignores the
stereo chemistry).

•  - Used to undo the last step.

•       - Simple ring templates.

•   - Used to save or open a user defined template.

•   - Used to open a structure or save changes.

•    - Used to copy and paste a selection.

•        - Used to rotate or flip structures.

•  - Used to clean a structure.

•
- Use to add an atom.

•  - Used to add a pseudo atom.

•  - Used to open the periodic table to select additional elements. Refer to the CMC-
se User Manual for a list of the atoms that are supported in CMC-se.
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3 Working with Files

3.1 Automatic molfile Recognition
When the editor is started a molfile will open automatically if it is included in the NMR dataset.
The search for the molfile begins in the expno directory and continues up to the project folder
level if the file is not found.

3.2 Define Default molfile Folder
It is possible to set a default molfile source folder in the user preferences dialog. To set this
directory, click File, then Preferences, enter the desired directory, then click Apply.

Figure 3.1: User Preferences used to Define the Default molfile Folder

3.3 Opening Files
The Structure Editor supports a variety of structure file types,
including: .mol, .sdf, .xyz, .pdb, .cml, .out.
The editor uses the molfile format exclusively, therefore when a file with a 3D structure format
is opened, the third (z) coordinate will be ignored.

Files can be opened by clicking the Open button  and selecting the desired file, or by
using Drag and Drop or Copy and Paste as described in the following sections.

3.3.1 Drag and Drop

To quickly open molfiles stored on the disk, it is possible to drag and drop the file to the editor
screen:
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Figure 3.2: Drag and Drop Function

3.3.2 Copy and Paste

Another comfortable way to enter molecules from public libraries it to copy the SD file text
from the browser and use the Paste button to import the structure.

Figure 3.3: Copy and Paste Function to Import Structures from the Web

Copy and Paste can also be used to transfer data between different structure editors:
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Figure 3.4: Copy and Paste Between Different Structure Editor

3.3.3 Open Templates

Another feature that provides a basis for structure drawing is access to a template library of
commonly used fragments. The Templates selection window lists all of the available

templates, to access this window click the  button. It is possible to add additional

templates to this window by saving them from the drawing area using the  button.
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Figure 3.5: Template Selection Window

To open a template, select the fragment (left mouse click) and confirm the selection by
clicking the OK button. Through this action the template is attached to the mouse and can be
placed on the screen or docked to an existing structure.

3.4 Saving and Exporting Structures
Structures can be saved or exported from the structure editor in molfile format, or saved as a
template for later use or for creating new structures.

3.4.1 Save and Save as

To save a structure, click the Save  button. To save a structure under a new name click

the Save as…  button, and enter the name and path in the dialog that appears:
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Figure 3.6: Save as… Dialog to Define the Name and Directory for the Structure

Three different directory options are available when saving a file:
• The current expno directory (default).
• A user defined standard molfile source folder (the path defined via File | (User)

Preferences | Directories | Directory of structure files for structure viewer).
• A local path on the local file system.

3.4.2 Saving a Structure as a Template

A structure may also be saved as a template, where it can be used later for the quick drawing
of structure fragments. To save a structure as a template, click the Save Structure As

Template  button. The following dialog appears:

Figure 3.7: Save Structure As Template Dialog

Type the structure template name in the edit field and click OK to save the template. The
saved templates can be accessed in the drawing process by clicking the Open Templates

 button on the vertical toolbar.

3.4.3 Export Structures

To use structures in a report, for example, it is possible to export the structure with the copy

and paste function. Select the structure to be copied and click the  button to copy the
structure into the clipboard. In an external application it is possible to paste the structure as a
picture or in molfile text format. Here are two examples:



Working with Files

14 / 42 H152853_3_003

Paste in a Word File

Figure 3.8: Copy Structure to Clipboard and Paste in Word as a Picture or molfile Text.

Paste in a OneNote File
It is possible to change the format, by selecting one of the options in Paste Options.

Figure 3.9: Copy Structure to Clipboard and Paste in OneNote as a Picture or molfile Text.
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4 Selection Mode

To activate the selection mode press the  button. The selection mode is necessary for the
following tasks:

• To select bonds and atoms.
• To move, rotate and change their settings.

There are several ways to select atoms or bonds:
• Click on an individual atom or bond. Only one atom or bond will be selected.
• Use the Ctrl or Shift key while clicking on atoms or bonds to select more than one

element.
• Click the left mouse button and drag the mouse while forming the shown rectangle to the

optimal size and leave the mouse button again. All atoms and bounds inside the selection
rectangle will be selected.

• Double click on an individual atom or bond to select the whole connected structure.

Selected atoms or bonds are always highlighted. When more than one element is in a
selection, a rectangle is displayed around them with a red arrow symbol that can be used to
rotate the selection:

Figure 4.1: Fragment Editor in Selection Mode

To quickly change back to the selection modus, right-click with the mouse.

4.1 Moving a Structure
To move an individual atom, click on it and drag it to the required position. The same is true
for bonds or any selection.
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4.2 Rotating a Structure

To rotate a structure, click on the arrow , shown with the selection and drag the mouse in
the preferred direction. Rotation is only possible with a selection consisting of at least two
atoms connected with a bond.

Figure 4.2: Structure Rotation

4.3 Setting a Bond Horizontally
A bond can be rotated to be exactly horizontal. This is especially useful because the selected
part of the structure can be rotated together with this bond. Either a selection can be rotated,
or (if no selection is available) it rotates the entire structure. Select the function Set Bond

Horizontal in the context menu by right-clicking on the bond, or click the  button and click
on the required bond.

4.4 Setting a Bond Vertically
A bond can be rotated to be exactly vertical. This is especially useful because the selected
part of the structure can be rotated together with this bond. Either a selection can be rotated,
or (if no selection is available) it rotates the entire structure. Select the function Set Bond

Vertical in the context menu by right-clicking on the bond, or click the  button and click on
the required bond.

4.5 Flipping On Bond
A selected part of the structure can be flipped on a bond, which may be important when
switching between cis-trans isomerism:

Figure 4.3: Change cis-trans Isomerism
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To do this:

• Select the required part of the structure and click the  button.
• Click on the required bond.
• Click again if you want to select a different position of the selected structure.

The mode can also be activated for the desired bond by selecting Flip on bond in the
context menu.

4.6 Flipping Horizontally

A structure can also be flipped horizontally by clicking the  button. Either the whole
structure can be flipped, or an individual selection.

4.7 Flipping Vertically

A structure can also be flipped vertically by clicking the  button. Either the whole structure
can be flipped, or an individual selection.

4.8 Refining a Structure
This feature allows the selected part of a structure to be refined automatically. To refine the

structure, make a selection and click the  button.
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5 Drawing Mode
In the drawing mode it is possible to draw structures or to extend them. The following drawing
modes are available:

• Normal draw mode , used to draw single bonds or add individual atoms.

• Draw chains mode , used for a quick and comfortable chains drawing.

5.1 Normal Drawing

Activate the Draw normal mode by clicking on the  button. To add an individual atom
(not connected with any other bond) to the structure, left click with the mouse on a location
where the atom should be.
Another possibility is to add a set of connected atoms. To do this, either confirm the
suggested bonds (considering the correct bond angle), or left-click and drag the mouse to an
individual position, illustrated in the figures below.
When drawing a set of connected atoms, either draw an additional bond considering the
correct bond angle, or draw individually positioned bonds. The suggested correct bond angle
is shown highlighted when the mouse touches the atom. To confirm this angle click the left
mouse button, as shown below:

Figure 5.1: Draw Bonds with Considering Correct Bond Angles.

An individual drawing is possible by left-clicking and dragging the mouse to an individual
position:

Figure 5.2: Drawing with Individual Bond Angle and Length
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5.2 Drawing Chains

Activate the Drawing Chains mode by clicking on the  button. To build a chain, left-click
and drag the mouse. During this process the current length of the chain is shown next to the
mouse at the end of the chain. Release the mouse button when the desired length is
reached:

Figure 5.3: Drawing Chain Bonds

The default drawing element is carbon, to change this, select another element from the
toolbar:

Or select one from the more comprehensive periodic table .
It is also possible to replace an existing atom by selecting a different element and clicking the
left mouse button on this atom. The old element will be changed to the current one. All atoms
will be connected by bonds with order equal one.

5.3 Using Simple Templates
The editor also provides simple templates for a quick drawing. To use a template click on one

of the available template       buttons. The selected ring
template will appear next to the mouse on the screen and can be placed with a left mouse
click. To extend a structure with a template, rotate the structure and try to dock the template
to the desired binding site, until green circles indicate a successfully recognized binding:

Figure 5.4: Illustration for the Simple use of Templates Through Docking.
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6 Change Structure Settings

6.1 Stereo and Aromatic Bonds
The bond type can be changed using the following buttons:

•  : Up stereo bond

•  : Down stereo bond

• . Undefined stereo bond

In this mode it is possible to toggle between the different possibilities (e.g. change the
direction of the bond or change back to normal single bond) by repeatedly clicking on the
already existing bond.

6.2 Bond Order
The bond order in the drawing modus can be changed by clicking on the required bond. Click

the  button to enter the drawing modus, then click on the required bond repeatedly to
change the bond order. This feature works in all of the drawing modes.

6.3 Atom Charge
The atom charge can be changed in the atom properties. To open the atom properties dialog
in the context menu, right click on the atom and select Atom Properties:

Figure 6.1: Atom Properties Dialog

Change the charge number and confirm it by clicking OK.

6.4 Removing Explicit Hydrogens
The structure editor always reads the molfile as IS. With the option Remove explicit
hydrogens in the context menu (left mouse click) it is possible to remove explicit hydrogens.
The hydrogens are not hidden, they are removed.
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Figure 6.2: Remove Explicit Hydrogens

More changes to the illustration of the structure are available in the setting: Display
Properties.
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7 Periodic Table
In the periodic table it is possible to change the element selection to draw atoms. To open the

periodic table dialog click the  button.

Figure 7.1: Periodic Table Dialog

The isotope value is Auto by default which means the isotope is not specified actually. If a
change is necessary, specify a concrete isotope by selecting it from the Nuclear Isotope
drop-down list box.
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8 Setting Display Properties

8.1 Display Properties
In the Display Properties dialog it is possible to change all or some part of the atoms in a

structure. Click the  button, or select the menu entry Display properties in the context
menu (left mouse click), to open the dialog:

Figure 8.1: Display Properties with Default Settings

Check or uncheck the information that should be displayed. A checkbox is enabled when at
least one atom selection is available, otherwise it will be disabled.

8.2 Zooming
There are the following zooming actions are possible:

•  Zoom In

•  Zoom Out

•  : The structure will be scaled to its actual size.

8.3 Move Display Center
It is possible to move the focus of an object by using the miniature window in the left top
window. Click with the mouse in this small window and drag the gray rectangle to the desired
place. The focus will change at the same time:
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Figure 8.2: Move the Focus of the Display

8.4 Setting Colors
The structure and background colors, as well as other TopSpin options, can be selected
using the Options I Preferences dialog. The editor uses the background color from the
spectrum section of the dialog as the background color and the axes color as the color for the
structure. To activate the new color settings the editor must be restarted.
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9 Show Structure Information
This context menu option will display additional structure information, such as the mass
information and international chemical identifier.

9.1 Mass Information
To display the mass information, click on Show mass information in the context menu: The
following dialog appears, display two types of mass: molecular weight and mono isotopic
mass:

Figure 9.1: Structure Mass Information

9.2 International Chemical Identifier
Click the option Show InChI identifier in the context menu to display the International
Chemical Identifier (InChI) identifier in a different file:

Figure 9.2: InChI Identifier

9.3 Starting Jmol

To work with the Jmol 3D Molecule Viewer click the  button. The current structure will be
reopened in the Jmol Viewer. For this option it is necessary to save any changes.
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9.4 Identify Structure with InChI Key
For a structure identification it is possible to search in different databases after the complete
structure or the connectivity pattern only. To get access to the search interface choose
Identify structure in the context menu of the structure editor (right clicking the mouse button)
and the following dialog will appear:

Figure 9.3: Identify Structure Dialog

The search is based on the InChI Key and shows the result in the default web browser.
Internet access is necessary for all search engines.
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10 View Spectrum Correlations
The View Spectrum Correlations is a special mode used to view the correlations between
atoms in the structure and multiplets. The correlation assignment procedure is described in
the Multiplet Analysis (mana command) documentation, refer this documentation more
details.
To view the correlations defined in Multiplet Analysis, open the same dataset twice with one
of both possibilities:

• Reopen the dataset with File | Reopen. The datasets will be arranged in stack
automatically.

• Open the same dataset twice by using the context menu (right mouse click) from the
dataset in the browser panel and selecting the Display In New Window item. The
browser panel is located on the left side of TopSpin user interface. Select the Window |
Arrange in stack item from the TopSpin main menu to view both windows at the same
time.

To show the correlations:
• Click the Spectrum tab on the first window and the Structure tab on the second (optionally

click the Fit All button to fit the structure into the sizes of the drawing area).

• Activate the correlation viewing mode by clicking the  button. The correlated atoms will
be highlighted with different colors if correlations exist.

• Move the mouse cursor over the correlated atoms. The cursor in the first window will
move to the corresponding multiplet as the mouse cursor passes over the correlated
atoms.

• The correlation viewing works in the opposite direction as well, when you move the mouse
cursor over the spectrum in the first window the corresponding atoms will be highlighted.
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Figure 10.1: Show Spectrum Correlations



SD File Viewer

H152853_3_003 31 / 42

11 SD File Viewer

11.1 Main User Interface Feature
The Multi-Structure Viewer is a viewer with several features to visualize Structure Data (SD)
files:

• The possibility of visualizing all structures in SD files.
• Scroll through a large amount of data and zoom into desired one.
• Working with compressed files save disk space (e.g. .zip or .gz files downloaded from

PubChem without decompression).

Figure 11.1: Multi-Structure Viewer

The editor provides a simple control with the following buttons:

•   - Used to open a SD file.

•    - Used to zoom in or zoom out to change the number of structures in the
overview.
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• - Used to toggle between atom numbers and single atoms.

11.1.1 Font and Format Conventions

Type of Information Font Examples

Shell Command,
Commands, 
“All what you can enter”

Arial bold Type or enter fromjdx 
zg

Button, Tab, Pane and Menu Names

“All what you can click”

Arial bold, initial letters
capitalized

Use the Export To File
button.

Click OK. 
Click Processing…

Windows, Dialog Windows, Pop-up
Windows Names

Arial, initial letters
capitalized

The Stacked Plot Edit
dialog will be displayed.

Path, File, Dataset and Experiment
Names
Data Path Variables
Table Column Names
Field Names (within Dialog
Windows)

Arial Italics $tshome/exp/stan/nmr/
lists

expno, procno, 

Parameters Arial in Capital Letters VCLIST

Program Code 
Pulse and AU Program Names 
Macros 
Functions
Arguments
Variables

Courier go=2
au_zgte
edmac

CalcExpTime()
XAU(prog, arg)
disk2, user2

AU Macro Courier in Capital
Letters

REX

PNO

Table 11.1: Font and Format Conventions

11.2 Open Files
The viewer supported the following strcture file types: .mol, .sdf, .sdf.gz, .sdf.zip.
Start the editor in the TopSpin menu bar by clicking Analyse | Structures | 2D Multi-
Structure Viewer or by using the vstrucs command.
As the editor opens the desired file has to be selected. Once the editor is open, it is possible

to change the file by clicking the Open  button.
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12 3D Structure Viewer

12.1 About Jmol Molecule Viewer
Jmol is a 3D Structure Viewer for displaying chemical structures. It is TopSpin’s
implementation of the open source Jmol molecule viewer (cf. jmol.sourceforge.net). For
general license information and Bruker changes to Jmol:

• Click Help => License Info
To start Jmol:

• Enter jmol on he command line

To start Jmol from the 2D Structure Editor, click the  button on the toolbar.

12.2 Jmol Functionality
The command jmol will switch the data window to the Molecule Viewer as shown:

TopSpin 1.3 and newer contains Jmol version 10. This has the following features:
• The viewer displays the structure file that resides in the expno of the current dataset. If

this does not exist, the structure file defined by the acquisition parameter CHEMSTR is
displayed. CHEMSTR can define a full pathname or a filename. In the latter case, the file
is searched for in the directory defined in the User Preferences. To set this directory, click
Options => Preferences, select Directory pathnames, enter a directory and click OK. If
no structure file is found, you can open one by clicking File => Open in the Molecule
Viewer

• The following structure file types are
supported: .xyz, .mol, .pdb, .cml, .out, .mmlgp, .res, .cif, .gpr, .h
in, .nwo.

• Secondary structure elements of proteins (backbone, cartoons, ribbons,...) can be
displayed in selectable sizes and colors.

• Mouse button effects:
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– Rotate a molecule around the x- and y-axis by pressing the left mouse button, and
moving the mouse left/right or up/down, respectively. 

– Rotate a molecule around the z-axis by pressing the middle mouse button and moving
the mouse left/right.

– Zoom in or out a molecule by pressing the middle mouse button, and moving the
mouse up or down.

• RASmol command scripts are supported. To send a RASmol command to the currently
displayed molecule enter:

– jmol <RASmol command>
– Here are some examples:

jmol zoom 400
jmol ribbon 200
jmol color ribbon yellow
You may create TopSpin macros containing RASmol commands. Just enter edmac on the
TopSpin command line and insert the RASmol commands in the appearing editor. Here is an
example:
jmol load /mystructures/alphahelix.pdb # load a structure
jmol backbone 0.7 # display its backbone with 0.7 Angstrom size
jmol color backbone yellow # change backbone color
jmol background green # change background color
jmol zoom 200 # zoom structure
The available RASmol commands are described in the Jmol Help menu item User Guide.

• Multiple molecules (or multiple aspects of one molecule) can be displayed simultaneously.
To do that just open multiple data sets or open the same dataset in multiple data windows
and click on the Structure Tab in each window.

A set of molecule structure files is delivered on the TopSpin DVD and stored in the directory:
<tshome>/classes/prop/StructureSamples/*
The following figure gives an impression of the capabilities of Jmol. The images were
extracted from the Jmol home page.
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12.3 More Information on Jmol Molecule Viewer
More information on the Jmol molecule viewer is available under the Jmol Help menu in sub
menu User Guide.
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13 Contact
Manufacturer

Bruker BioSpin GmbH
Silberstreifen 4
D-76287 Rheinstetten
Germany

E-Mail: nmr-support@bruker.com
http://www.bruker.com
WEEE DE43181702

Bruker BioSpin Hotlines
Contact our Bruker BioSpin service centers.
Bruker BioSpin provides dedicated hotlines and service centers, so that our specialists can
respond as quickly as possible to all your service requests, applications questions, software
or technical needs.
Please select the service center or hotline you wish to contact from our list available at:
https://www.bruker.com/service/information-communication/helpdesk.html

mailto:nmr-support@bruker.com
http://www.bruker.com
https://www.bruker.com/service/information-communication/helpdesk.html
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